This chapter completes the introduction to basic 2-D drafting and editing techniques and brings you to a very significant plateau in your developing AutoCAD technique. The techniques you have learned in Part I form the basis for everything you do in more complex two- and three-dimensional drawings.

In this chapter, you begin to use AutoCAD’s very powerful Object Snap and Object Tracking features. These take you to a new level of accuracy and efficiency as a CAD operator. You also learn to BREAK entities on the screen into pieces so that they can be manipulated or erased separately, to shorten objects at intersections with other objects using the TRIM command, or to lengthen them with the EXTEND and LENGTHEN commands. Finally, you move into the world of paper space as you begin to use AutoCAD’s layout and multiple viewport system.

**TASKS**

6.1 Selecting Points with Object Snap (Single-Point Override)
6.2 Selecting Points with OSNAP (Running Mode)
6.3 Object Snap Tracking
6.4 Using the OFFSET Command (Creating Parallel Objects with OFFSET)
6.5 BREAKing Previously Drawn Objects
6.6 Shortening Objects with the TRIM Command
6.7 Extending Objects with the EXTEND Command
6.8 Using STRETCH to Alter Objects Connected to Other Objects
6.9 Changing Lengths with the LENGTHEN Command
6.10 Creating Plot Layouts
6.11 Review Material
6.12 WWW Exercise 6 (Optional)
6.13 Drawing 6-1: Bike Tire
Chapter 6 Object Snap

6.1 Selecting Points with Object Snap (Single-Point Override)

GENERAL PROCEDURE

1. Enter a drawing command, such as LINE, CIRCLE, or ARC.
2. Right-click while holding down the Ctrl key.
3. Select an object snap mode from the shortcut menu.
4. Point to a previously drawn object.

or

1. Enter a drawing command, such as LINE, CIRCLE, or ARC.
2. Select an object snap mode from the Object Snap toolbar.
3. Point to a previously drawn object.

Some of the drawings in the last two chapters have pushed the limits of what you can accomplish accurately on a CAD system with incremental snap alone. Object snap is a related tool that works in a very different manner. Instead of snapping to points defined by the coordinate system, it snaps to geometrically specifiable points on objects that you have already drawn. There are 13 varieties of object snap, and each can be used as a one-time option for selecting a point (single-point override) or turned on to affect all point selection (running object snap). In this task, we introduce the single-point method and then move on to the running mode in the next task.

Let’s say you want to begin a new line at the endpoint of one that is already on the screen. If you are lucky, the endpoint might be on a snap point, but it is just as likely not to be. Turning snap off and moving the cursor to the apparent endpoint might appear to work, but when you zoom in you probably will find that you have missed the point. Using object snap is the only precise way, and it is as precise as you could want. Let’s try it.

To prepare for this exercise, begin a new drawing using the 1B template.

Draw a $6 \times 6$ square with a circle inside, as in Figure 6-1.

To keep the circle centered, draw the square with the RECTANGLE command with corners at (6, 3) and (12, 9). Then the circle can be centered at (9, 6).

The Polar, Osnap, and Snap buttons should be off for the rest of this exercise. Dyn may be on or off.

Enter the LINE command (type L or select the Line tool).

We are going to draw a line from the lower left corner of the square to a point on a line tangent to the circle, as shown in Figure 6-2. This task would be extremely difficult without object snap. The corner is easy to locate, because you probably have drawn it on snap, but the tangent might not be.
We use an endpoint object snap to locate the corner and a tangent object snap to locate the tangent point. When AutoCAD asks for a point, you can select an object snap mode from the object snap shortcut menu.

- At the Specify first point: prompt, instead of specifying a point, hold down the Shift or Ctrl key and right-click.
  This opens the shortcut menu illustrated in Figure 6-3.

- Select Endpoint.
  This tells AutoCAD that you are going to select the start point of the line by using an endpoint object snap rather than by direct pointing or by entering coordinates.
  Now that AutoCAD knows that we want to begin at the endpoint of a previously drawn entity, it needs to know which one.
Move the cursor near the lower left corner of the square.

When you are close to the corner, AutoCAD recognizes the endpoint of the lines there and indicates this with an orange box surrounding the endpoint. This object snap symbol is called a marker. There are different-shaped markers for each type of object snap. If you let the cursor rest here for a moment, a label appears, naming the type of object that has been recognized, as shown in Figure 6-4. This label is called a snap-tip. Also notice that if the crosshairs are inside the marker, they lock onto the endpoint. This action can be turned on or off and is called the magnet setting. You do not have to be locked on to the endpoint, however. As long as the endpoint marker is showing, the endpoint is selected.

With the endpoint object snap marker showing, press the pick button.

The orange endpoint box and the snap-tip disappear, and there is a rubber band stretching from the lower left corner of the square to the cursor position. In the command area, you see the Specify next point: prompt.

We use a tangent object snap to select the second point.

At the Specify next point or [Undo]: prompt, open the shortcut menu by pressing Shift + right-click and then select Tangent.

Move the cursor to the right and position the crosshairs so that they are near the lower right side of the circle.

When you approach the tangent area, you see the yellow tangent marker, as shown in Figure 6-5. Here again, if you let the cursor rest you see a snap-tip.
With the tangent marker showing, press the pick button. AutoCAD locates the tangent point and draws the line. Notice the power of being able to precisely locate the tangent point in this way.

Press Enter to exit the LINE command.

Your screen should now resemble Figure 6-2.

We repeat the process now, but start from the midpoint of the bottom side of the square instead of its endpoint. Also, this time we use the Object Snap toolbar instead of the shortcut menu. Object snap is such an important feature that you might find yourself leaving this toolbar open frequently.

Move the cursor over any toolbar on your screen and right-click to open the toolbar shortcut menu.

Select Object snap.

This opens the Object Snap toolbar shown in Figure 6-6.

Move the toolbar anywhere out of the way, or dock it along one side.
Enter the **LINE** command.
At the prompt for a point, select the **Snap to Midpoint** tool from the toolbar.

All of the Osnap modes have fairly obvious icons. Snap to Midpoint is the second tool in the second panel.

Position the aperture anywhere along the bottom side of the square so that an orange triangle, the snap to midpoint marker, appears at the midpoint of the line.
Press the pick button.
At the prompt for a second point, select the **Snap to Tangent** tool from the toolbar.

Snap to Tangent is the last tool on the right in the third panel.
Position the aperture along the right side of the circle so that the tangent symbol appears and then press the pick button.
Press Enter or the spacebar to exit the **LINE** command.

At this point your screen should resemble Figure 6-7.

That’s all there is to it. Remember these steps: (1) Enter a command; (2) when AutoCAD asks for a point, specify an object snap mode; (3) position the crosshairs near an object to which the mode can be applied and let AutoCAD find the point.

**Note:** Both the shortcut menu and the toolbar are efficient methods of specifying a single-point object snap. However, you can also type the name of any object snap method when AutoCAD asks for a point. All modes have aliases that are the first three letters of the mode: end for endpoint, tan for tangent, and so on.
6.2 Selecting Points with OSNAP (Running Mode)

**GENERAL PROCEDURE**

1. Select object snap modes from the Drafting Settings dialog box.
2. Click the Osnap button on the status bar so that it is on.
3. Enter drawing commands.
4. If there is more than one object snap choice in the area, cycle through using the Tab key.

So far we have been using object snap one point at a time. Because object snap is not constantly in use for most applications, this single-point method is common. Often, however, you will find that you are going to be using one or a number of object snap types repeatedly and do not need to select many points without them. In this case, you can keep object snap modes on so that they affect all point selection. This is called *running object snap*. We use this method to complete the drawing shown in Figure 6-8. Notice how each line is drawn from a midpoint or corner to a tangent point on the circle. This is easily done with running object snaps.

- Click the Osnap button on the status bar so that it is on.
  - When the Osnap button is on, you are in running object snap mode. The modes that are in effect depend on the AutoCAD default settings, or whatever settings were last selected. To change settings or see what settings are on, we open the Drafting Settings dialog box. You used this dialog box in Chapter 2.
- Right-click on the status bar Osnap button.
  - This opens a small shortcut menu with three options: On, Off, and Settings. On and off are redundant because you can turn Osnap on and off more easily by left-clicking as usual. However, Settings is very useful.
- Select Settings.
- This opens the Drafting Settings dialog box with the Object Snap tab on top, as shown in Figure 6-9.

![Figure 6-8](image-url)
You can find a description of all of the object snap modes on the chart in Figure 6-10, but for now we use three: Midpoint, Intersection, and Tangent. Midpoint and Tangent you already know. Intersection snaps to the point where two entities meet or cross. We use an intersect instead of an endpoint to select the remaining three corners of the square, even though an endpoint could be used instead.

- Select the Clear All button.
  
  This will clear any previous object snap selections that may have been made on your system.

- Select Midpoint, Intersection, and Tangent.
  
  When you are finished, your dialog box should resemble Figure 6-9. Notice that Object Snap On (F3) is checked at the top of the box, and Object Snap Tracking On (F11) is not checked. We save Object Snap Tracking for Task 6.3.

- Click OK.

- Enter the LINE command.

- Position the aperture so that the lower right corner is within the box.
  
  An orange X, the intersection marker, appears.
## Basic Two-Dimensional Entities

<table>
<thead>
<tr>
<th>TYPE</th>
<th>APPEARANCE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>CENter</td>
<td><img src="image" alt="CENter" /></td>
<td>Snaps to the center of an arc, circle, ellipse, or elliptical arc.</td>
</tr>
<tr>
<td>ENDpoint</td>
<td><img src="image" alt="ENDpoint" /></td>
<td>Snaps to the closest endpoint of an arc, elliptical arc, line,pline, polyline, ray, or to the closest corner of a trace, solid, or 3D face.</td>
</tr>
<tr>
<td>INSertion</td>
<td><img src="image" alt="INSertion" /></td>
<td>(See Chapter 10) Snaps to the insertion point of a block, attribute, shape, or text.</td>
</tr>
<tr>
<td>INTersection</td>
<td><img src="image" alt="INTersection" /></td>
<td>Snaps to crossing or meeting point of arcs, lines, circles, ellipses, elliptical arcs, mlines, polylines, rays, splines, or xlines.</td>
</tr>
<tr>
<td>APParent Inter</td>
<td><img src="image" alt="APParent Inter" /></td>
<td>Snaps to apparent crossing or meeting point of arcs, lines, circles, ellipses, elliptical arcs, mlines, polylines, rays, splines, or xlines. If apparent intersection and intersection are on at the same time, varying results may occur.</td>
</tr>
<tr>
<td>MiDpoint</td>
<td><img src="image" alt="MiDpoint" /></td>
<td>Snaps to the midpoint of an arc, circle, ellipse, elliptical arc, line, pline, polyline, solid, spline, or xline.</td>
</tr>
<tr>
<td>NEArest</td>
<td><img src="image" alt="NEArest" /></td>
<td>Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, pline point, polyline, spline, or xline.</td>
</tr>
<tr>
<td>NODe</td>
<td><img src="image" alt="NODe" /></td>
<td>Snaps to a point object.</td>
</tr>
<tr>
<td>PERpendicular</td>
<td><img src="image" alt="PERpendicular" /></td>
<td>Snaps to a point on an arc, circle, ellipse, elliptical arc, line, pline, ray, solid, spline, or xline.</td>
</tr>
<tr>
<td>QUAdrant</td>
<td><img src="image" alt="QUAdrant" /></td>
<td>Snaps to nearest quadrant point of an arc, circle, ellipse, or elliptical arc. 0, 90, 180, 270 degrees</td>
</tr>
<tr>
<td>QUick</td>
<td><img src="image" alt="QUick" /></td>
<td>(Modifies other modes) Snaps to the first snap point found. Quick must be used in conjunction with other object snap modes.</td>
</tr>
<tr>
<td>TANgent</td>
<td><img src="image" alt="TANgent" /></td>
<td>Snaps to the tangent of an arc, circle, ellipse, or elliptical arc.</td>
</tr>
<tr>
<td>EXTension</td>
<td><img src="image" alt="EXTension" /></td>
<td>Snaps to the extension point of an object. Establish an extension path by moving the cursor over the endpoint of an object. A marker is placed on the endpoint. While the endpoint is marked, the cursor snaps to the extension path of the endpoint.</td>
</tr>
<tr>
<td>PARallel</td>
<td><img src="image" alt="PARallel" /></td>
<td>Snaps to extension parallel with an object. When the cursor is moved over the endpoint of an object, the endpoint is marked and the cursor snaps to the parallel alignment path to that object. The alignment path is calculated from the current &quot;from point&quot; of the command.</td>
</tr>
</tbody>
</table>

**Figure 6-10**
With the intersection marker showing, press the pick button.
AutoCAD selects the intersection of the bottom and the right sides and
gives you the rubber band and the prompt for the next point.
Move the crosshairs up and along the right side of the circle until the
tangent marker appears.
With the tangent marker showing, press the pick button.
AutoCAD constructs a new tangent from the lower right corner to the circle.
Press the spacebar to complete the LINE command sequence.
Press the spacebar again to repeat LINE so you can begin with a new
start point.
We continue to move counterclockwise around the circle. This should begin
to be easy now.
Position the aperture along the right side of the square so that the
midpoint triangle marker appears.
With the midpoint marker showing, press the pick button.
AutoCAD snaps to the midpoint of the side.
Move up along the upper right side of the circle so that the tangent
marker appears.
With the tangent marker showing, press the pick button.
Press the spacebar to exit LINE.
Press the spacebar again to repeat LINE and continue around the circle
drawing tangents like this: upper right corner to top of circle, top
side midpoint to top left of circle, upper left corner to left side, and
left side midpoint to lower left side.
Remember that running Osnap modes should give you both speed and accuracy,
so push yourself a little to see how quickly you can complete the figure.
Your screen should now resemble Figure 6-8. Before going on, you should study
the object snap chart, Figure 6-10. Before you can effectively analyze situations and
look for opportunities to use object snap and object snap tracking, you need to
have a good acquaintance with all of the object snap modes.

Tip: Occasionally, you might encounter a situation where there are several possible
object snap points in a tight area. If AutoCAD does not recognize the one
you want, you can cycle through all the choices by pressing the Tab key repeatedly.

6.3 Object Snap Tracking

GENERAL PROCEDURE
1. Select Object Snap modes from the Drafting Settings dialog box.
2. Click the Otrack button on the status bar so that it is on.
3. Enter drawing commands.
4. To acquire a point for tracking, position the cursor so that the Osnap marker
   appears, but do not click.
5. Use the temporary construction lines that AutoCAD draws from this acquired point.
Object snap tracking creates temporary construction lines from designated object snap points. Once you are in a Draw command, such as LINE, any object snap point that can be identified in an active object snap mode can be acquired. An acquired point is highlighted with a yellow cross. Once a point is acquired, object snap tracking automatically throws out temporary construction lines from this point. Construction lines are dotted lines like those used by polar tracking. They extend to the edge of the display and are drawn along the horizontal and vertical from the acquired point, or along polar tracking angles. Try the following:

To begin this task, the Osnap button should be on with the Endpoint mode in effect; all other modes from the last exercise should be turned off.

Remember the following steps:
1. Right-click the Osnap button.
2. Select Settings.
3. Click Clear All in the dialog box.
4. Check Endpoint.
5. Click OK.

Click the Dyn button to turn dynamic input off.

This is technically not necessary, but you will be able to see other things happening on your screen more easily without the dynamic input display.

Click the Otrack button on the status bar so that it is in the on position.

Enter the LINE command.

Select a first point to the left of the square and circle, as shown by Point 1 in Figure 6-11.

Point Acquisition

To take the next step, you need to learn a new technique called point acquisition. Before a point can be used for object snap tracking, it must be acquired, which is a form of selection. To acquire a point, move the cursor over it so that the object

![Figure 6-11](image-url)
snap marker shows and pause for about a second without clicking. Try it with the following steps:

- Move the cursor over the lower left corner of the square, Point 2 in Figure 6-12, so that the endpoint marker appears.
- Pause.
- Now move the cursor away from the corner.

If you have done this correctly, a small orange cross appears at the corner intersection, as shown in Figure 6-13, indicating that this point has been acquired for object snap tracking. (Repeating this procedure over the same point removes the cross.)

- Move the cursor to a position left of Point 2 and even with the horizontal lower side of the square, as shown in Figure 6-14.

You see a construction line and a tracking tip like those shown in Figure 6-14.
Move the cursor over and down to a position even with and below the vertical left side of the square, as shown in Figure 6-15.

You see a different construction line and tracking tip, like those shown in Figure 6-15.

These construction lines are interesting, but they do not accomplish a great deal because your square is probably constructed on grid snap points anyway. Let's try something more difficult and a lot more interesting. Here we use two acquired points to locate a point that currently is not specifiable either in object snap or incremental snap.

Move the cursor up and acquire Point 3, as shown in Figure 6-16.

Point 3 is the endpoint of the line drawn from the midpoint of the top side of the square to a point tangent to the circle. You should now have two acquired points, with two orange crosses showing, one at Point 2 and one at Point 3.

Move the cursor slowly along the left side of the square.
You are looking for Point 4, the point where the vertical tracking line from Point 2 intersects the horizontal tracking line from Point 3. When you near it, your screen should resemble Figure 6-17. Notice the double tracking tip Endpoint: <90, Endpoint: <180.

- With the double tracking tip and the two tracking lines showing, press the pick button.

  A line is drawn from Point 1 to Point 4.

- Press Enter or the spacebar to exit the LINE command.

  Before going on, we need to turn off the running Osnap to Endpoint mode.

- Click the Osnap button or press F3 to turn off running Osnap modes.

If you have followed this exercise closely, you have already greatly increased the power of your understanding of CAD technique. You will find many opportunities to use object snap and object snap tracking from now on.
Next we move on to a very powerful editing command called OFFSET. Before leaving object snap, be sure that you have studied the chart in Figure 6-10, which shows examples of all the object snap modes.

### 6.4 Using the OFFSET Command (Creating Parallel Objects with OFFSET)

#### GENERAL PROCEDURE

1. Select the Offset tool from the Modify toolbar.
2. Type or show an offset distance.
3. Select object to offset.
4. Show which side to offset.

OFFSET is one of the most powerful editing commands in AutoCAD. With the combination of object snap and the OFFSET command, you can become completely free of incremental snap and grid points. Any point in the drawing space can be precisely located. Essentially, OFFSET creates parallel copies of lines, circles, arcs, or polylines. You can find a number of typical applications in the drawings at the end of this chapter. In this brief exercise, we perform an offset operation to draw some lines through points that would be very difficult to locate without OFFSET.

**Pick** Select Offset from the Modify menu, or the Offset tool from the Modify toolbar, as shown in Figure 6-18.

AutoCAD prompts

Specify offset distance or [Through]<Through>

There are three methods. You can type a distance, show a distance with two points, or pick a point that you want the new copy to run through (the through option). We type a distance.

**Pick** Type .257.

We have chosen this rather odd number to make the point that this command can help you locate positions that would be difficult to find otherwise. AutoCAD prompts for an object:

Select object to offset or <exit>:

**Pick** Select the diagonal line drawn in the last exercise.

AutoCAD now needs to know whether to create the offset image above or below the line:

Specify point on side to offset:

![Figure 6-18](image-url)
Pick a point anywhere below the line.

Your screen should now resemble Figure 6-19. AutoCAD continues to prompt for objects to offset using the same offset distance. You can continue to create offset objects at the same offset distance by pointing and clicking.

Pick the line just created.

Pick any point below the line.

A second offset line is added, as shown in Figure 6-20. As long as you stay within the OFFSET command, you can select any object to offset using the same offset distance.

Pick the circle in the square.

Pick any point inside the circle.

An offset circle is added, as shown in Figure 6-20.
Part I Basic Two-Dimensional Entities

Continue pointing and clicking to create additional offset circles, as shown in Figure 6-20.

Press Enter to exit the OFFSET command.

When you exit OFFSET, the offset distance is retained as the default, so you can return to the command and continue using the same distance.

Next we turn to five useful commands that allow you to shorten and lengthen objects.

6.5 BREAKing Previously Drawn Objects

GENERAL PROCEDURE

1. Type Br, select Break from the Modify menu, or select the Break tool from the Modify toolbar.
2. Select an object to be broken.
3. Show the first point of the break.
4. Show the second point of the break.

The BREAK command allows you to break an object on the screen into two entities, or to cut a segment out of the middle or off the end. The command sequence is similar for all options. The action taken depends on the points you select for breaking. BREAK works on lines, circles, arcs, and polylines. (Polylines are discussed in Chapter 9.)

In preparation for this section, clear your screen of objects left from previous tasks and draw a 10.00 horizontal line across the middle of your screen, as in Figure 6-21.

Exact lengths and coordinates are not important. Also, be sure to turn off object snap.

Figure 6-21
AutoCAD allows for four different ways to break an object, depending on whether the point you use to select the object is also to be considered a break point. You can break an object at one point or at two points, and you have the choice of using your object selection point as a break point.

We begin by breaking the line you have just drawn into two independent lines using a single break point, which is also the point used to select the line.

Select the Break at Point tool from the Modify toolbar, as shown in Figure 6-22.

Notice that there is a Break tool that is not the same as the Break at Point tool. Also, be aware that the noun/verb or pick first sequence does not work with BREAK.

AutoCAD prompts you to select an object to break:

Select object:

You can select an object in any of the usual ways, but notice that you can only break one object at a time. If you try to select more—with a window, for example—AutoCAD highlights only one. Because of this, it is best to indicate the object you want to break by pointing to it.

Tip: Object snap modes work well in edit commands such as BREAK. If you wish to break a line at its midpoint, for example, you can use the Midpoint object snap mode to select the line and the break point.

Select the line by picking any point near its middle. (The exact point is not critical for this exercise; if it were, we might use a midpoint object snap.)

The line has now been selected for breaking, and because there can be only one object, you do not have to press Enter to end the selection process, as you often do in other editing commands. AutoCAD prompts as follows:

Specify second break point or [First point]: _f

When you are using the Break at Point tool, AutoCAD does not take the point you use for selection as the first point of the break. In the command area, notice that the "_f" for the first point option is entered automatically. This means that now you have the opportunity to select the same point or a different point as the point at which to break this line.

Point to the same point that you just used to select the line, or type @.

The @ symbol is shorthand for the last point entered. In this sequence, AutoCAD automatically enters @ for the second break point. This means that there is only one break point. The line will be broken, but nothing will be erased.
The break is complete. To demonstrate that the line is really two lines now, we select the right half of it for our next break.

Press Enter or the spacebar to repeat the BREAK command, or select the Break tool from the Modify toolbar.

The Break tool is just below the Break at Point tool on the toolbar, or next to it if your toolbar is horizontal.

Point to the line on the right side of the last break.

The right side of the line should be highlighted, as in Figure 6-23. Clearly, the original line is now being treated as two separate entities.

We shorten the end of this dotted section of the line. Assume that the point you just used to select the object is the point where you want it to end; now all you need to do is to select a second point anywhere beyond the right end of the line.

Select a second point beyond the right end of the line.

Your line should now be shortened, as in Figure 6-24.

Next we cut a piece out of the middle of the left side.
Chapter 6 Object Snap

219

Select the left side of the original line with a point toward the left end.

We want to cut a piece out of the middle of the left side, so the next point needs to be to the right of the first point, but still toward the middle of the left-hand line.

Note: It is not necessary that the second point be on the line at all. It could be above or below it, as in Figure 6-25. AutoCAD breaks the line along a perpendicular between the point we choose and the line we are breaking. The same system would apply if we were breaking a polyline. An arc or a circle would be broken along a line between the selected point and the center of the arc or circle.

Select a second point on or off the line, somewhat to the right of the first point.

Your line should now have a piece cut out, as in Figure 6-25. Notice that there are now three lines on the screen, one to the left and two shorter lines to the right of the last break.

BREAK is a useful command, but there are times when it is cumbersome to shorten objects one at a time. The TRIM command has some limitations that BREAK does not have, but it is much more efficient in situations in which you want to shorten objects at intersections.

6.6 Shortening Objects with the TRIM Command

GENERAL PROCEDURE

1. Type Tr or select Trim from the Modify menu or the Trim tool from the Modify toolbar.
2. Select a cutting edge or edges.
3. Right-click to end the cutting-edge selection process.
4. Select an object to trim.
5. Select other objects to trim.
6. Press Enter to return to the command prompt.
The TRIM command works wonders in many situations where you want to shorten objects at their intersections with other objects. It works with lines, circles, arcs, and polylines (see Chapter 9). The only limitations are that you must have at least two objects and they must cross or meet. If you are not trimming to an intersection, use BREAK.

In preparation for exploring TRIM, clear your screen and then draw two horizontal lines crossing a circle, as in Figure 6-26. Exact locations and sizes are not important.

First, we use the TRIM command to go from Figure 6-26 to Figure 6-27.

Type Tr or select Trim from the Modify menu or the Trim tool from the Modify toolbar, as shown in Figure 6-28.

The first thing AutoCAD wants you to specify is at least one cutting edge. A cutting edge is an entity you want to use to trim another entity. That is, you want the trimmed entity to end at its intersection with the cutting edge.
Chapter 6 Object Snap

Current settings: Projection = UCS, Edge = None
Select cutting edges...
Select objects or <Select All>:

The current settings are relevant to 3-D drawing and need not concern you at this point. (For your information, Projection and Edge refer to system variables that determine the way AutoCAD interprets boundaries and intersections in 3-D space.) The second line reminds you that you are selecting edges first—the objects you want to trim are selected later. The third line prompts you to select objects to use as cutting edges, or press Enter for the Select All option. The option of selecting all objects is a useful one, as we demonstrate shortly.

For now, select the circle as an edge and use it to trim the upper line.

1. Point to the circle.
   The circle becomes dotted and remains so until you leave the TRIM command. AutoCAD prompts for more objects until you indicate that you are finished selecting edges.

2. Right-click to end the selection of cutting edges.
   You are prompted for an object to trim:
   Select object to trim or shift-select to extend or [Fence/Crossing/Project/Edge/eRase/Undo]:

   This prompt allows you to shift over to the EXTEND command by holding down the Shift key. Then select an object, specify fence or crossing selections, or shift into a mode where objects are erased before you proceed to select objects to trim. We follow a simple procedure to trim off the segment of the upper line that lies outside the circle on the left. The important thing is to point to the part of the object you want to remove, as shown in Figure 6-27.

3. Point to the upper line to the left of where it crosses the circle.
   The line is trimmed immediately, but the circle is still dotted, and AutoCAD continues to prompt for more objects to trim. Note how this differs from the BREAK command, with which you could only break one object at a time.

   Also notice that you have an undo option, so that if the trim does not turn out the way you wanted, you can back up without having to leave the command and start over.

4. Point to the lower line to the left of where it crosses the circle.
   Now you have trimmed both lines.

5. Press Enter or the spacebar to end the TRIM operation.
   Your screen should resemble Figure 6-27.
More complex trimming is also easy. The key is that you can select all visible objects or as many edges as you like. An entity can be selected as both an edge and an object to trim, as we demonstrate.

- Repeat the TRIM command.
- Press Enter to select all objects.

In this case, AutoCAD will not highlight all objects, but will proceed as if all objects had been selected. There is no need to complete object selection because everything is already selected.

- Point to each of the remaining two-line segments that lie outside the circle on the right and to the top and bottom arcs of the circle to produce the bandage-shaped object in Figure 6-29.
- Press Enter to exit the TRIM command.

### 6.7 Extending Objects with the EXTEND Command

**GENERAL PROCEDURE**

1. Type Ex or select Extend from the Modify menu or the Extend tool from the Modify toolbar.
2. Select a boundary or boundaries.
3. Press Enter to end the boundary selection process.
4. Select the object to extend.
5. Select other objects to extend.
6. Press Enter to return to the command prompt.

If you compare the procedures of the EXTEND command and the TRIM command, you notice a remarkable similarity. Just substitute the word “boundary” for “cutting edge” and the word “extend” for “trim” and you’ve got it. These two commands are conceptually related and are so efficient that it is sometimes good practice to draw a temporary cutting edge or boundary on your screen and erase it after trimming or extending.
Leave Figure 6-29, the bandage, on your screen and draw a vertical line to the right of it, as in Figure 6-30.

We use this line as a boundary to which to extend the two horizontal lines, as in Figure 6-31.

Type Ex or select Extend from the Modify menu or the Extend tool from the Modify toolbar, as shown in Figure 6-32.

You are prompted for objects to serve as boundaries:

```
Current settings: Projection=UCS, Edge=0n
Select boundary edges...
Select objects or <Select All>:
```

Look familiar? As with the TRIM command, any of the usual selection methods work and there is an option for selecting all objects. For our purposes, simply point to the vertical line.

Point to the vertical line on the right.

You are prompted for more boundary objects until you exit object selection.
Part I
Basic Two-Dimensional Entities

Right-click or press the spacebar to end the selection of boundaries. AutoCAD now asks for objects to extend:

Select object to extend or shift-select to trim or [Fence/Crossing/Project/Edge/eRase/Undo]:

Point to the right half of one of the two horizontal lines. You have to point to the line on the side closer to the selected boundary. Otherwise, AutoCAD looks to the left instead of the right and gives you the following message:

Object does not intersect an Edge

Also, you can select objects to extend only by pointing. Windowing, crossing, or last selections do not work. Arcs and polylines can be extended in the same manner as lines.

Point to the right half of the other horizontal line. Both lines should be extended to the vertical line.

Your screen should resemble Figure 6-31.

Press the spacebar to exit the EXTEND command.

6.8 Using STRETCH to Alter Objects Connected to Other Objects

GENERAL PROCEDURE

1. Type S or select the Stretch tool from the Modify toolbar or select Stretch from the Modify menu.
2. Select objects to stretch, using at least one window or crossing selection.
3. Press Enter to end selection.
4. Show the first point of stretch displacement.
5. Show the second point of stretch displacement.

The STRETCH command is a phenomenal timesaver in special circumstances in which you want to move objects without disrupting their connections to other objects. Often STRETCH can take the place of a whole series of moves, trims, breaks, and extends. It is commonly used in such applications as moving doors or windows within walls without having to redraw the walls.

The term stretch must be understood to have a special meaning in AutoCAD. When a typical stretch is performed, some objects are lengthened, others are shortened, and others are simply moved.
There is also a Stretch mode in the grip edit system, as we have seen previously. We take a look at it later in this section.

First, we do a simple stretch on the objects you have already drawn on your screen. This gives you a good basic understanding of the STRETCH command. Further experimentation on your own is recommended.

1. Type S, select Stretch from the Modify menu, or select the Stretch tool from the Modify toolbar, illustrated in Figure 6-33.

    ![Figure 6-33](image)

    AutoCAD prompts for objects to stretch in the following manner:
    
    Select objects to stretch by crossing-window or crossing-polygon...

    This prompt reminds you of a unique quality of the STRETCH command procedure. You must include at least one crossing-window or crossing-polygon selection in your selection set. Beyond that you can also include other selection types. This ensures that you include all the objects in an intersection in the stretch procedure. If this is not your intent, you probably should be using a different modifying command.

2. Point to the first corner of a crossing box, as shown by Point 1 (P1) in Figure 6-34.

    ![Figure 6-34](image)

    AutoCAD prompts for a second corner:
    
    Specify opposite corner:
Part I  Basic Two-Dimensional Entities

Point to a second corner, as shown by Point 2 (P2) in Figure 6-34.
AutoCAD continues to prompt for objects, so we need to show that we are through selecting.

Right-click or press the spacebar to end the selection process.
Now you need to show the degree and direction of stretch you want. In effect, you show AutoCAD how far to move the objects that are completely within the box. Objects that cross the box are extended or shrunk so that they remain connected to the objects that move.
The prompt sequence for this action is the same as the sequence for a move:
Specify base point or [Displacement] <Displacement>:

Pick any point near the middle of the screen, leaving room to indicate a horizontal displacement to the right, as illustrated in Figure 6-35.
AutoCAD prompts:
Specify second point of displacement <or use first point as displacement>:

Pick a second point to the right of the first, as shown in Figure 6-35.
Having Ortho on ensures a horizontal move (press F8).
The arcs are moved to the right and the horizontal lines are shrunk as shown.
Notice that nothing here is literally being stretched. The arcs are being moved and the lines are being compressed. This is one of the ways STRETCH can be used.

Try performing another stretch like the one illustrated in Figures 6-36 and 6-37.
Here the lines are being lengthened, while one arc moves and the other stays put, so that the original bandage is indeed stretched.

Stretching with Grips
Stretching with grips is a simple operation best reserved for simple stretches.
Stretches like the ones you have just performed with the STRETCH command are
possible in grip editing, but they require careful selection of multiple grips. The results are not always what you expect, and it takes more time to complete the process. The type of stretch that works best with grips is illustrated in the following exercise:

✦ Pick the lower horizontal line.
   The line is highlighted and grips appear.

✦ Pick the vertical line.
   Now both lines should appear with grips, as in Figure 6-38. We use one grip on the horizontal line and one on the vertical line to create Figure 6-39.

✦ Pick the grip at the right end of the horizontal line.
   As soon as you press the pick button, the autoedit system puts you into STRETCH mode and the grip changes color.
In the command area, you see the following:

**STRETCH**

Specify stretch point or [Base point/Copy/Undo/eXit]:

We stretch the line to end at the lower endpoint of the vertical line.

Move the crosshairs slowly downward and observe the screen.

If Ortho is off, you see two rubber bands. One represents the line you are stretching, and the other connects the crosshairs to the grip you are manipulating.

Pick the grip at the bottom of the vertical line.

Your screen should resemble Figure 6-39. Notice how the grip on the vertical line works like an object snap point.
Try one more grip stretch to create Figure 6-40. Stretch the endpoint of the upper line just as you did the lower.

In the next task, you learn the LENGTHEN command—one more edit command for changing the lengths of lines and arcs.

### 6.9 Changing Lengths with the LENGTHEN Command

<table>
<thead>
<tr>
<th>GENERAL PROCEDURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select Lengthen from the Modify menu.</td>
</tr>
<tr>
<td>2. Type initials to specify a length option.</td>
</tr>
<tr>
<td>3. If necessary, type a value.</td>
</tr>
<tr>
<td>4. Select an object to lengthen.</td>
</tr>
<tr>
<td>5. Select another object or press Enter to exit the command.</td>
</tr>
</tbody>
</table>

The LENGTHEN command can be used to lengthen or shorten lines, polylines, and arcs using four different methods. In this exercise, we use two methods to further manipulate the objects in Figure 6-40. We begin by lengthening and then shortening the vertical line at the right of the figure.

- Type `len` or select Lengthen from the Modify menu.

  The prompt that follows shows the different lengthening methods:

  Select an object or [DElta/Percent/Total/DYnamic]:

  DElta lengthens an object by a specified amount and Percent lengthens it by a percentage of the current length. Total changes the current length to a specified value, and DYnamic allows you to change length by cursor movement.
If you select an object at this prompt, its current length is reported in the command area. We work with DElta and DYnamic.

1. Type de for the Delta option or right-click and select Delta from the shortcut menu.
   
   AutoCAD prompts:
   
   Enter Delta length or [Angle]<0.00>:
   
   Angle allows you to lengthen an arc by a specified angle. To change a linear length, type in a value. A positive value causes objects to be lengthened, and a negative value causes shortening.

2. Type 1.
   
   AutoCAD prompts you to select an object:
   
   Select an object to change or [Undo]:
   
   Pick a selection point on the upper half of the vertical line.
   
   The object is lengthened by one unit upward, as shown in Figure 6-41. AutoCAD continues to prompt for objects. You can select any line, arc, or polyline. Also, you can pick the same line again to add another one-unit length. Try it.

3. Pick another point on the upper half of the vertical line.
   
   The object is lengthened again.
   
   Now try lengthening the arc in the middle of the figure.

4. Pick a point on the upper half of the arc.
   
   The arc is lengthened by one unit along a circular path, as shown in Figure 6-42. Now try the Dynamic option.

5. Press Enter or the spacebar to exit LENGTHEN.

6. Press Enter or the spacebar again to repeat the command.

7. Type dy for the Dynamic option or right-click and select Dynamic from the shortcut menu.

---

Figure 6-41
You are prompted to select objects.

- Select the angled line at the top of the drawing, choosing a point on the right half of the line.
  
  AutoCAD shows a rubber band and lengthens or shortens the selected line dynamically as you move the cursor.

- Move the cursor back and forth on the screen to get a feel for how the rubber band and crosshairs work in this command option.
  
  The rubber band connects to the old endpoint and the line is lengthened or trimmed by an imaginary line running from the crosshairs perpendicular to the line.

- Select any point and observe the resulting change.

- Type u to undo the change.

- Press Enter to exit the LENGTHEN command.

In the next task, you take a giant leap in plotting technique as you begin to use paper space, multiple layouts, and multiple viewports within layouts.

### 6.10 Creating Plot Layouts

<table>
<thead>
<tr>
<th>GENERAL PROCEDURE</th>
</tr>
</thead>
</table>
| 1. Right-click a layout tab and select New layout.  
2. Define plot settings.  
3. Create paper space viewports.  
4. Switch to model space to position or edit objects in the drawing.  
5. Switch to paper space to plot.  
6. Type or select Plot.  
7. Preview plot, change parameters, and execute plotting as usual. |
Up until now, we have plotted everything directly from model space. Plotting from model space has its uses, particularly in the early stages of a design process. However, when your focus shifts from modeling issues to presentation issues, paper space layouts have much more to offer. The separation of model space and paper space in AutoCAD allows you to focus entirely on modeling and real-world dimensions when you are drawing, and then shift your focus to paper output issues when you plot. On the drafting board, all drawings are committed to paper from the start. People doing manual drafting are inevitably conscious of scale, paper size, and rotation from start to finish. When draftspersons first begin using CAD systems, they still tend to think in terms of the final hard copy their plotter will produce even as they are creating lines on the screen. The AutoCAD plotting system takes full advantage of the powers of a CAD system, allowing us to ignore scale and other drawing paper issues entirely, if we wish, until it is time to plot.

In addition, the paper space world allows us to create multiple views of the same objects without copying or redrawing them, and to plot these viewports simultaneously. In this task, we create two layouts of Drawing 5-1, the flanged bushing from the last chapter. The first contains only one viewport. The second is used to demonstrate some basic principles of working with multiple viewports.

**Opening Layout1**

To begin this exercise, you should open Drawing 5-1, illustrated in Figure 6-43.

If you do not have Drawing 5-1 available, you can approximate it by doing the following:

1. Erase all objects from your screen.
2. Set Limits to (0,0) and (12,9). This is critical. If you use different limits, the exercise is difficult to follow.
3. Draw a circle with diameter 3.50 centered at (3.00,4.00).

![Figure 6-43](image-url)
4. Draw a second circle with diameter 2.50 centered at the same point.
5. Draw a rectangle with first corner at (6.50,2.75) and second corner at (10.00,5.25).

With Drawing 5-1 on your screen, or an approximation, you are ready to begin.

Before leaving model space, turn off the grid (press F7).

Layouts have their own grid, so if you leave the model space grid on you see overlapping grids that are very confusing.

Click the Layout1 tab at the bottom of the drawing area.

This might automatically call up the Page Setup Manager discussed in Chapter 4. If so, you can ignore it for now. We return to it for the next layout.

If necessary, close the Page Setup Manager.

Once the dialog box is closed, you should see an image similar to the one in Figure 6-44. This is a simple one-viewport layout. AutoCAD has automatically created a single viewport determined by the extents of your drawing. Paper space viewports are sometimes called floating viewports because they can be moved and reshaped. They are somewhat like windows from paper space into model space. Try the remaining steps:

Select the viewport border, just as you would select any AutoCAD object.
Floating viewports are, in fact, AutoCAD objects and are treated and stored as such. You can move them, stretch them, copy them, and erase them. Editing the viewport does not affect the model space objects within the viewport. When a viewport is selected, the border is highlighted and grips are shown at each corner.

- Type e or select the Erase tool from the Modify toolbar.
  This eliminates the viewport and leaves you with the image of a blank sheet of paper. Without a viewport, you have no view of model space.
- Undo the Erase to bring the viewport back.
- Now try to select any of the objects within the viewport.
  You cannot. As long as you are in paper space, model space objects are not accessible. To gain access to model space objects while in a layout view, you must work in model space inside a selected viewport. This is easily done by double-clicking inside a viewport.
- Double-click anywhere within the viewport.
  Two things happen. The border of the viewport takes on a bold outline and the Paper button on the status bar switches to Model, indicating that you are now in model space. You also notice that the MSPACE command has been entered at the command prompt. Notice the difference between working within a viewport in a layout and switching into model space by clicking the Model tab. If you click the Model tab, the layout disappears and you are back in the familiar model space drawing area.
- Try selecting objects in your viewport again.
  Model space objects are now available for editing or positioning within the viewport. While in the model space of a viewport, you cannot select any objects drawn in paper space, including the viewport border.
- Try selecting the viewport border.
  You do not have access to this paper space object. When you point outside the viewport border you see the selection arrow rather than the crosshairs and selection box.
- Double-click anywhere outside the viewport border.
  This returns you to paper space.
  Next we create a more complex layout.

Creating a New Layout
Layouts are saved automatically and assigned to tabs. You can create new layouts and layout tabs, and you can delete any layout tab. You cannot delete the model tab. There are several ways to create a new layout. The simplest is to use the layout shortcut menu. You probably already have Layout1 and Layout2 tabs, so we create a Layout3 tab and rename it.

- Right-click the Layout1 or Layout2 tab.
  This opens the shortcut menu illustrated in Figure 6-45. You see the following options: New layout, which creates a new tab; From template, which creates a new layout from a layout template; Delete, which deletes the currently
selected layout; Rename, to rename the selected layout tab; Move or Copy, which can be used to copy a layout or change the order of tabs; and Select All Layouts, which allows all layouts to be sent to the plotter at once. The bottom panel of the menu gives convenient access to the Page Setup Manager and Plot dialog boxes.

Select New layout from the shortcut menu.

A Layout3 tab is added. (If you have no Layout2, then Layout2 is added instead.)

Right-click the Layout3 tab to open the shortcut menu again.

Select Rename.

A simple Rename Layout dialog box appears, as shown in Figure 6-46.

Type 3view and click OK.

The name on the Layout3 tab changes to 3view. We enter this layout, change some plot settings, and create three floating viewports.

Select the 3view tab.

Plot settings can be applied directly to a layout or taken from a previously defined page setup. Since we are starting from scratch in defining this layout, we go directly to the Plot dialog box and define our settings there. The layout shortcut menu provides easy access to the Plot dialog box.
Part I
Basic Two-Dimensional Entities

Right-click on the 3view layout tab to open the shortcut menu.
Select Plot from the shortcut menu.

In this exercise, we use a D-size drawing sheet for our layout. If you do not have a D-size plotter, we recommend that you use AutoCAD's DWG6 ePlot driver, which is designed to create electronic plots that can be sent out over the Internet or a local network. If you prefer to use a different-size paper, you have to make adjustments as you go along. Using A-size, for example, most specifications can be divided by four. We will include A-size specifications at critical points in case you don't have access to a D-size plotter or want to use a printer.

In the Printer/plotter panel, select a plotting device that has a D-size sheet option.
In the Paper size panel, select an ANSI D (34 × 22) paper size.
Notice that Layout is now the default selection in the What to plot list. We have not encountered this selection because it is not present when you plot from model space.
If necessary, check Landscape in the Drawing orientation panel.
Click the Apply to Layout button at the bottom of the dialog box. This is important. The plot settings we have defined will not be applied to the current layout unless we click this button.
We are now ready to exit the Plot dialog box and work directly on our layout. Since we have applied our settings to the layout, they will be retained if we close the Plot dialog, but not if we click cancel.
Click the close button in the upper right corner of the dialog box.
AutoCAD will adjust the layout image to show the currently defined floating viewport on a D-size drawing sheet. Whatever size viewport AutoCAD shows is okay, because we will erase it anyway.
Select the floating viewport and type e or select the Erase tool.
You are now looking at a blank sheet of paper in paper space once again. Take a moment to explore the limits of this drawing sheet.
Turn on the paper space grid (press F7 or click the Grid button on the status bar).
Turn on incremental snap (press F9 or click the Snap button on the status bar).
Move the cursor over the lower left corner of the paper grid and locate (0,0).
This is the origin of the plot, indicated by the corner of the dashed border that shows the effective drawing area.
Move the cursor to the upper right corner of the effective drawing area.
This is less than the limits of the grid. The exact point depends on your plotter. With the AutoCAD DWF6 ePlot driver and D-size paper, it is (33.50, 20.50).
Your screen is now truly representative of a drawing sheet. The plot is made 1-to-1, with 1 paper space screen unit equaling 1 inch on the drawing sheet.
There is little reason to do it any other way, because the whole point of paper space is to emulate the paper on the screen. Now it is time to create viewports.

- Type `mv` or open the View menu, select Viewports, and then 1 Viewport.

  Either of these methods enters the VPORTS command. AutoCAD prompts:

  Specify corner of viewport or
  [ON/OFF/Fit/Hideplot/Lock/Object/Polygonal/Restore/2/3/4]<Fit>:

  We deal only with the Specify corner option in this exercise. With this option, you create a viewport just as you would a selection window.

- Pick point (1.00,1.00) at the lower left of your screen, as shown in Figure 6-47.

  If you are not using D-size paper, you can do fine by making your viewports resemble ours in size, shape, and location.

- Pick an opposite corner, as shown in Figure 6-47. This is (20,13) on a D-size sheet.

  Your screen is redrawn with the drawing extents at maximum scale centered within the viewport.

---

**Figure 6-47**
Now we create a second viewport to the right of the first.

- Repeat VPORTS.
- Pick point (24.00,1.00), as shown in Figure 6-47.
- Pick point (32.00,13.00), as shown.

You have now created a second viewport. Notice that the images in the two viewports are drawn at different scales. Each is drawn to fit within its viewport. This can create problems later when you add dimension and text. You want to maintain control over the scale of objects within viewports and have a clear knowledge of the relationships among scales in different viewports. For this, we use the ZOOM scale feature of the ZOOM command. We create different zoom magnifications inside the two viewports.

- Double-click inside the left viewport.

  This takes you into model space within the left viewport. We are going to zoom so that the two-view drawing is in a precise and known scale relation to paper space.

- Type z to enter the ZOOM command.

  Notice the ZOOM command prompt:

  `Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>:`

In this task, we use two new options, the paper space scale factor option (nXP) and the Center option.

- Type 2xp (on A-size paper divide these factors by four, so you will use .5xp).

  This creates only a slight change in the left viewport. XP means times paper. It allows you to zoom relative to paper space units. If you zoom 1xp, then a model space unit takes on the size of a current paper space unit, which in turn equals 1 inch of drawing paper. We zoomed 2xp. This means that one unit in the viewport equals two paper space units, or 2 inches on paper. We now have a precise relationship between model space and paper space in this viewport. The change in presentation size is trivial, but the change in terms of understanding and control is great.

  Now we set an XP zoom factor in the right viewport so that we control not only the model space/paper space scale relations, but the scale relations among viewports as well.

- Click inside the right viewport to make it active.

  You are already in model space, so double-clicking is unnecessary.

- Reenter the ZOOM command.

  In the right viewport, we are going to show a close-up image of the right side view. To accomplish this, we need a larger zoom factor and we need to be centered on the right side view.

- Type c for the Center option.

  AutoCAD asks you to specify a center point.

- Pick a point on the center line near the center of the flange.
Look at Figure 6-48. The point you select becomes the center point of the right viewport when AutoCAD zooms in.

AutoCAD prompts:

Enter magnification or height<3.00>:

Accepting the default would simply center the image in the viewport. We specify an XP value here.

Type 4xp.

Your right viewport is dynamically magnified to resemble the one in Figure 6-48. In this enlarged image, one model space unit equals 4 inches in the drawing sheet (1 = 1 on A size).

**Tip:** You might wish to pan slightly to the left or right to position the image in the viewport. Notice that you can use the scroll bars to pan inside the active viewport without losing horizontal or vertical alignment.

Now that you have the technique, we create one more enlargement, focusing on one of the circle of holes in the flange.

- Double-click anywhere outside the two viewports to return to paper space.
- Enter the MVIEW command.
- Pick point (1.00,14.00).
- Pick point (9.00,20.00).
Enter model space in the new viewport and zoom in, centering on the hole at the bottom of the flange in the front view, at six times paper in the new viewport.

This is tricky and might require the use of a Center or Quadrant object snap. Remember that you can access a single-point object snap by holding down Shift, right-clicking, and then selecting from the Osnap shortcut menu.

Your screen should resemble Figure 6-49.

Before proceeding to plot, try a print preview to ensure that you are ready.

Select the Plot preview tool from the Standard toolbar.

This full preview should look very much like the layout image. This is the beauty of the AutoCAD plotting system. You have a great deal of control and the ability to assess exactly what your paper output will be before you actually plot the drawing.

Press esc to exit the preview.

Maximize Viewport Button

Before going on, we introduce the maximize viewport button on the right of the status bar. This button will not only allow you to switch into model space in any viewport, but will maximize that viewport to fit the display. Once you have maximized a viewport, you can cycle through other viewports and maximize them one at a time. Try this:
Click the Maximize Viewport button on the status bar, illustrated in Figure 6-50.

If you entered the model space of a viewport before clicking the button, AutoCAD would maximize that viewport. Otherwise, it will maximize the first viewport you defined. The maximized image will show you whatever is in the viewport, along with whatever portion of the drawing will fit the display at the magnification defined for that viewport.

Click the small arrow to the right or left of the button.

The arrows cycle you through other viewports in the order they were defined.

Click the arrows to continue cycling through your three viewports.

When you are done, click the Maximize button again.

This will minimize the viewport and return you to the paper space layout image. (If you pause with the selection arrow on the button, you will notice that it is now labeled as the Minimize button.)

**Plotting the Multiple-View Drawing**

Now we are ready to plot. Plotting a multiple-viewport drawing is no different from plotting from a single view. However, now that you have two or three different layouts as well as model space, you need to make sure the layout or layouts you want to plot are selected before you enter the Plot dialog box.

**Tip:** The selection controls for layout tabs are the same as those for files in Microsoft Office and other Windows applications. To select two or more adjacent tabs, use Shift + Left click. To select individual layout tabs that are separated by other layout tabs, use Ctrl + Left click.

With the 3view tab selected, select the Plot tool from the Standard toolbar, or right-click on the 3view layout tab and select Plot from the shortcut menu.

At this point you should have no need to adjust settings within the Plot dialog box because you have already made adjustments to the page setup and the plotting device. Notice that Layout is the default for Plot area.

Prepare your plotter. (Make sure you use the right size paper.)

Click OK.

**Note:** If you have done this exercise using the DWG6 ePlot driver, you will note that AutoCAD sends your plot to a file rather than to a plotter. Any
Part I Basic Two-Dimensional Entities

drawing can be saved to a file to be plotted later, but anytime you use the ePlot utility your plot will first be saved to a file so that it can be sent over the Internet.

**Important:** Be sure to save this drawing with its multiple-viewport 3view layout before leaving this chapter, because we return to it in Chapter 8 to explore scaling dimensions between model space and paper space.

### 6.11 Review Material

**Questions**

1. Why is it important to keep object snap turned off when you are not using it? What are two simple ways to turn running Osnap on and off?
2. At what point in a command procedure would you use an object snap single-point override? How would you signal the AutoCAD program that you want to use an object snap?
3. How do you access the Object snap shortcut menu?
4. What is an acquired point? How do you acquire a point? How do you eliminate an acquired point?
5. How do you use BREAK to shorten a line at one end? When would you use this procedure instead of the TRIM command? How would you accomplish the same thing with LENGTHEN?
6. You have selected a line to extend and a boundary to extend it to, but AutoCAD gives you the message “Object does not intersect an edge.” What happened?
7. What selection method is always required when you use the STRETCH command?
8. Why is it usual practice to plot 1-to-1 in paper space?
9. Why do we use the Zoom XP option when zooming in floating model space viewports?
10. How is CAD different from manual drafting with regard to issues of scaling and paper size?

**Drawing Problems**

1. Draw a line from (6,2) to (11,6). Draw a second line perpendicular to the first starting at (6,6).
2. Break the first line at its intersection with the second.
3. There are now three lines on the screen. Draw a circle centered at their intersection and passing through the midpoint of the line going up and to the right of the intersection.
4. Trim all the lines to the circumference of the circle.
5. Erase what is left of the line to the right of the intersection and trim the portion of the circle to the left, between the two remaining lines.
6.12 WWW Exercise 6 (Optional)

You conclude Part I of your exploration of online CAD with two more websites that serve as launching pads with links to many other AutoCAD and CAD-related websites. In addition, we offer a challenge to create a design using object snap and a limited number of commands.

- Connect to your Internet service provider.
- Type browser or open the Web toolbar and select the Browser tool.
- If necessary, navigate to our companion website at www.prenhall.com/dixriley.

Enjoy your visit.
6.13 Drawing 6-1: Bike Tire

This drawing can be done very quickly with the tools you now have. It makes use of one object snap, three trims, and a polar array. Be sure to set the limits large, as suggested.

Drawing Suggestions

GRID = 1.00
SNAP = 0.125
LIMITS = (0,0)(48,36)

- Begin by drawing the 1.25, 2.50, 24.00, and 26.00 diameter circles centered on the same point near the middle of your display.
- Draw line (a) using a quadrant object snap to find the first point on the inside circle. The second point can be anywhere outside the 24 circle at 0 degrees from the first point. The exact length of the line is insignificant because you will trim it back to the circle.
- Draw line (b) from the center of the circles to a second point anywhere outside the 24 circle at an angle of 14 degrees. Use the coordinate display or polar tracking to construct this angle. This line also will be trimmed.
- Trim lines (a) and (b) using the 24 circle as a cutting edge.
- Trim the other end of line (b) using the 1.25 circle as a cutting edge.
- Construct a polar array, selecting lines (a) and (b). There are 20 items in the array, and they are rotated as they are copied.
BIKE TIRE

Drawing 6-1


6.14 Drawing 6-2: Archimedes Spiral

This drawing and the next go together as an exercise you should find interesting and enjoyable. These are not technical drawings, but they give you valuable experience with important CAD commands. You create a spiral using a radial grid of circles and lines as a guide. Once the spiral is done, you use it to create the designs in Drawing 6-3.

Drawing Suggestions

GRID = 0.5  SNAP = 0.25
LIMITS = (0,0)(18,12)  LTSCALE = 0.5

- The alternating continuous and hidden lines work as a drawing aid. If you use different colors and layers, they are more helpful. Because all circles are offset 0.50, you can draw one continuous and one hidden circle, then use the OFFSET command to create all the others.
- Begin by drawing one of the continuous circles on Layer 0, centered near the middle of your display, then offset all the other continuous circles.
- Draw the continuous horizontal line across the middle of your six circles and then array it in a three-item polar array.
- Set to Layer 2, draw one of the hidden circles, then offset the other hidden circles.
- Draw a vertical hidden line and array it as you did the horizontal continuous line.
- Set to Layer 1 for the spiral itself.
- Turn on a running object snap to Intersection mode and construct a series of three-point arcs. Be sure to turn off any other modes that might get in your way. Start points and endpoints will be on continuous line intersections; second points always will fall on hidden line intersections.
- When the spiral is complete, turn off Layers 0 and 2. There should be nothing left on your screen, but the spiral itself. Save it or go on to Drawing 6-3.

Grouping Objects

Here is a good opportunity to use the GROUP command. GROUP is discussed more fully in Chapter 10, but you will find it useful here. GROUP defines a collection of objects as a single entity so that they can be selected and modified as a unit. The spiral you have just drawn is used in the next drawing, and it is easier to manipulate if you GROUP it. For more information, see Chapter 10.

1. Type g.
2. In the Object Grouping dialog box, type Spiral for a group name.
3. Click New.
4. Select the six arcs with a window.
5. Right-click to end selection.
6. Click OK.

The spiral can now be selected, moved, rotated, and copied as a single entity.
ARCHIMEDES SPIRAL

Drawing 6-2
6.15 Drawing 6-3: Spiral Designs

These designs are different from other drawings in this book. There are no dimensions, and you use only edit commands now that the spiral is drawn. Below the designs is a list of the edit commands you need. Don’t be too concerned with precision. Some of your designs might come out slightly different from ours. When this happens, try to analyze the differences.

Drawing Suggestions

\[
\text{LIMITS} = (0,0)(34,24)
\]

These large limits are necessary if you wish to draw all of these designs on the screen at once.

In some of the designs and in Drawing 6-4, you need to rotate a copy of the spiral and keep the original in place. You can accomplish this by using the grip edit rotate procedure with the copy option. Setting up Polar snap to track at various angles might also be useful.

How to Rotate an Object and Retain the Original Using Grip Edit

1. Select the spiral.
2. Pick the grip around which you want to rotate, or any of the grips if you are not going to use the grip as a base point for rotation.
3. Right-click and select Rotate from the shortcut menu.
4. Right-click and type b or select Base point from the shortcut menu, if the design needs a base point not on a grip. In this exercise, the base point you choose for rotation depends on the design you are trying to create.
5. Right-click and type c or select Copy from the shortcut menu.
6. Show the rotation angle(s).
7. Press the spacebar to exit the grip edit system.
SPIRAL DESIGNS

(Make from Drawing 6-2)

Drawing 6-3
6.16 Drawing 6-4: Grooved Hub

This drawing includes a typical application of the rotation technique just discussed. The hidden lines in the front view must be rotated 120 degrees and a copy retained in the original position. There are also good opportunities to use MIRROR, object snap, object snap tracking, and TRIM.

**Drawing Suggestions**

- **GRID** = 0.5  
  **SNAP** = 0.0625
- **LIMITS** = (0,0)(12,9)  
  **LTSCALE** = 1

- Draw the circles in the front view and use these to line up the horizontal lines in the left side view. This is a good opportunity to use object snap tracking. By acquiring the quadrant of a circle in the front view, you can track along the horizontal construction lines to the left side view.
- There are several different planes of symmetry in the left side view, which suggests the use of mirroring. We leave it up to you to choose an efficient sequence.
- A quick method for drawing the horizontal hidden lines in the left side view is to acquire the upper and lower quadrant points of the 0.625-diameter circle in the front view to track horizontal construction lines. Draw the lines in the left side view longer than actual length and then use TRIM to erase the excess on both sides of the left side view.
- The same method can be used to draw the two horizontal hidden lines in the front view. A slightly different method that does not use object tracking is to snap lines directly to the top and bottom quadrants of the 0.25-diameter circle in the left side view as a guide and draw them all the way through the front view. Then trim to the 2.25-diameter circle and the 0.62-diameter circle.
- Once these hidden lines are drawn, rotate them, retaining a copy in the original position.

**Creating the Multiple-View Layout**

Use this drawing to create the multiple-view layout shown below the dimensioned drawing. This three-view layout is very similar to the one created in Task 6.10. Exact dimensions of the viewports are not given. You should create them depending on the paper size you wish to use. What should remain consistent is the scale relationships among the three viewports. On an A sheet, for example, if the largest viewport is zoomed 0.5xp, then the left close-up is 1.0xp and the top close-up is 1.5xp. These ratios have to be adjusted for other sheet sizes.
GROOVED HUB

Drawing 6-4
6.17 Drawing 6-5: Cap Iron

This drawing is of a type of blade used in a wood plane. When wood is planed, the cap iron causes it to curl up out of the plane so that it does not jam. There are several good applications for the TRIM command here.

Drawing Suggestions

GRID = 1.00
SNAP = 0.125
LIMITS = (0,0)(18,12)
LTSSCALE = 0.25

• The circle with a hidden line outside a continuous line represents a tapped hole. The dimension is given to the hidden line; the continuous inner line is drawn with a slightly smaller radius that is not specified.

• The figure near the center of the top view that has two arcs with 0.38 radii can be drawn exactly the same way as the bandage discussed earlier in this chapter. Draw a circle and two horizontal lines and then trim it all down.

• The small 0.54 and 0.58 arcs in the front view can be drawn using Start, End, Radius.

• The small vertical hidden lines in the front view can be drawn using techniques introduced in the last drawing. Draw lines down from snap points on the figures in the top view and then trim them, or use object snap tracking to create lines with excess length and then trim them. For the tapped hole and the arced opening in the middle, use the right and left quadrant points of the arcs and circle as acquired points or snap points.
Chapter 6 Object Snap

CAP IRON
Drawing 6-5

Note:
Save This Drawing (use on CSA-5C)
6.18 Drawing 6-6: Deck Framing

This architectural drawing might take some time, although there is nothing in it you have not done before. Notice that some of the settings are quite different from our 1B template, so be sure to adjust them before beginning.

![Deck Framing Image]

**Drawing Suggestions**

- UNITS = Architectural
- PRECISION = 0’-0"
- LIMITS = (0’,0’)(48’,36’)
- GRID = 1’
- SNAP = 2”

- Whatever order you choose for doing this drawing, we suggest that you make ample use of COPY, ARRAY, OFFSET, and TRIM.
- Keep Ortho on, except to draw the lines across the middle of the squares, representing upright posts.
- With snap set at 2”, it is easy to copy lines 2” apart, as you have to do frequently to draw the 2 x 80 studs.
- You might need to turn Snap off when you are selecting lines to copy, but be sure to turn it on again to specify displacements.
- Notice that you can use ARRAY effectively, but there are three separate arrays. They are all 16” on center, but the double boards in several places make it inadvisable to do a single array of studs all the way across the deck. What you can do, however, is draw, copy, and array all the “vertical” studs at the maximum length first and then go back and trim them to their various actual lengths using the “horizontal” boards as cutting edges.
DECK FRAMING

Drawing 6-6
6.19 Drawing 6-7: Tool Block

In this drawing, you need to take information from a three-dimensional drawing and develop it into a 3view drawing. The finished drawing should be composed of the Top View, Front View, and Side View. The reference drawing shows a portion of each view to be developed. You are to complete these views.

Drawing Suggestions

- Begin by drawing the top view. Use the top view to line up the front view and side view.
- The slot with the angular lines must be drawn in the front view before the other views. These lines can then be lined up with the top and side view and used as guides to draw the hidden lines.
- Be sure to include all the necessary hidden lines and center lines in each view.
Chapter 6  Object Snap

TOOL BLOCK

Drawing 6–7